คู่มือการใช้โปรแกรม
Photoshop
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คู่มือการใช้โปรแกรม
Adobe Photoshop 7.0
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สารบัญ

พื้นที่การทำงาน (Work Area)
2

เครื่องมือต่างๆ (Toolbox)
3

การใช้งาน Palettes
7
การเปิดไฟล์ภาพ (Open)
12
การสร้างไฟล์ใหม่ (New)
13
การบันทึกข้อมูลลงบนไฟล์ (Save)
14
การกำหนดพื้นที่ เพื่อแก้ไขและตกแต่งภาพ (Selection)
16
การใช้งาน Foreground และ Background Color
20
การใช้งาน Type Tool
20
การใช้งาน Layer
22
การทำภาพโดยใช้ Filter
24
การใช้งาน Layer Style
27
การเปลี่ยนรูปร่างของรูป (Transform)
28
การปรับค่าความสว่าง/ความคมชัด (Brightness/Contrast)
28
การปรับขนาดของชิ้นงาน 
29
การตัดกรอบของรูป (Crop)
30
Adobe Photoshop 7.0 คืออะไร


Adobe Photoshop 7.0 เป็นโปรแกรมคอมพิวเตอร์ที่รวบรวมเครื่องมือสำหรับตกแต่งภาพประสิทธิภาพสูง เพื่อการทำงานระดับมาตรฐานสำหรับนักออกแบบมืออาชีพที่ต้องการสร้างสรรค์งานกราฟิกที่โดดเด่น ทั้งงานที่ใช้บนเว็บและงานสิ่งพิมพ์
พื้นที่การทำงาน (Work Area)

Work Area หรือพื้นที่การทำงานของโปรแกรม Adobe Photoshop จะประกอบด้วยเครื่องมือสำหรับการตกแต่งไฟล์ภาพต่าง ๆ ดังนี้ 
1. Menu bar คือส่วนที่แสดงชื่อเมนูต่างๆ ของโปรแกรม
2. Toolbox คือส่วนของอุปกรณ์ต่าง ๆ ที่ใช้ในการสร้างชิ้นงานหรือตกแต่งภาพ
3. Tool options bar คือส่วนที่กำหนดคุณสมบัติของอุปกรณ์ที่เลือกจาก Toolbox

4. Palettes คือส่วนที่ใช้ตรวจสอบและกำหนดคุณสมบัติต่าง ๆ ให้กับรูปภาพ
5. Status bar คือส่วนที่แสดงรายละเอียดต่าง ๆ ของชิ้นงาน เช่น ขนาดของมุมมองรูปภาพ ขนาดของไฟล์ คำแนะนำการใช้งานของอุปกรณ์ที่เลือกจาก Toolbox
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เครื่องมือต่างๆ (Toolbox)
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หมายเหตุ ปุ่ม Toolbar ที่มีเครื่องหมายสามเหลี่ยมเล็กๆ อยู่ด้านล่างขวาเมื่อกดปุ่มสามเหลี่ยมดังกล่าว โปรแกรมจะแสดงเครื่องมืออื่นๆ ออกมาเช่น  [image: image2.jpg]



 Tool ที่น่าสนใจ
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Marquee Tool
เป็นการเลือกแบบสี่เหลี่ยมผืนผ้า, วงกลม, แถวขนาด 1 พิกเซลส์ หรือคอลัมน์ 1 พิกเซลส์ 
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Move Tool 

ใช้เพื่อเลื่อนส่วนที่เลือก หรือไว้เลื่อน Layer และ Guide ต่างๆ
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Lasso Tool
จะใช้เพื่อสร้าง Selection แบบอิสระ, แบบ Polygonal (ตามจุดที่คลิก) และ Magnetic (ดึงเข้าหาขอบรูปภาพ)
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Magic Wand Tool 
ใช้เลือกพื้นที่บริเวณที่มีสีเดียวกัน
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Crop Tool 

ใช้ในการเลือกบางส่วนของรูปภาพ
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Slice Tool
ใช้ในการสร้าง Slice
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Slice Selection Tool
ใช้เลือก Slice ที่คุณสร้างขึ้นมา
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Healing Brush Tool
ใช้ในการระบายสี เพื่อซ่อมแซมรูปภาพให้สมบูรณ์แบบ
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Patch Tool
ใช้เฉพาะในบริเวณที่เลือกไว้เท่านั้น เพื่อให้เกิดความสมบูรณ์ของรูปภาพ โดยใช้ลวดลาย หรือใช้ส่วนที่เลือกในภาพเป็นต้นฉบับ
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Brush Tool 
ใช้ในการวาดเส้น Brush ต่างๆ
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Pencil Tool 

ใช้ในการวาดเส้นที่มีขอบชัดเจน
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Clone Stamp Tool
ใช้ก็อปปี้รูปโดยอาศัยรูปภาพต้นฉบับ
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Pattern Stamp Tool 
ใช้เพื่อวาดรูปโดยใช้บางส่วนของรูปภาพที่มีอยู่เป็นต้นฉบับ
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 History Brush Tool  

ใช้กลับคืนรูปภาพเดิมจาก State หรือ Snapshot ของรูปเดียวกัน
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Art History Brush Tool
ใช้ในการวาดรูป จาก State หรือ Snapshot ของรูปนี้โดยอาศัยรูปแบบของ Stoke ที่มีสไตล์หลากหลาย ช่วยให้สไตล์ ของภาพดูต่างออกไป
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Eraser Tool 

ใช้ลบรูปภาพหรือลบบางส่วนของพิกเซลส์และทำการเก็บส่วนต่างๆ เป็น State ต่างๆ ใน History Palette
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Magic Eraser Tool 
ใช้ลบรูปภาพบริเวณที่มีสีเดียวกันให้กลายเป็นพื้นที่โปร่งใส (Transparent) โดยการคลิกเพียงครั้งเดียว
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Background Eraser Tool
ใช้ลบรูภาพบางส่วนให้กลายเป็นพื้นที่โปร่งใสโดยการลากเมาส์
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Gradient Tools

ใช้เพื่อไล่สีระหว่างสีหลายๆ สี ในแบบต่างๆ Straight-line,  Radial, Angle, Reflected และ Diamond
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Paint Bucket Tool 

ใช้ในการเติมสี Fill ในบริเวณที่เป็นสีเดียวกันด้วยสีของ Foreground

	[image: image23.png]



Blur Tool 

ใช้ในการปรับขอบรูปภาพให้ดูเบลอ
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Sharpen Tool 

ใช้ในการปรับขอบของรูปภาพให้มีความคมชัดเพิ่มขึ้น
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Smudge Tool
ใช้ในการดึงภาพคล้ายกับการใช้นิ้วถูกับภาพ ทำให้เหมือนกับมีรอยเปื้อน
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Dodge Tool 

ใช้เพิ่มความสว่างแสงในส่วนต่างๆ ของรูปภาพ
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Burn Tool 

ใช้ลดความสว่างทำให้รูปภาพดูมืดลง
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Sponge Tool 

ใช้เปลี่ยนสีในส่วนต่างๆ ของรูปภาพ โดยการปรับค่าความเข้มสี
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Path Selection Tool
ใช้เพื่อเลือก Shape หรือ Path เพื่อแสดง Anchor Paint, Direction Line และ Direction Paint 
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Type Tool 
ใช้ในการสร้างตัวหนังสือลงบนรูปภาพ
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Type Mask Tool
ใช้สร้าง Selection เป็นรูปร่างตัวหนังสือ
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Pen Tools
ใช้ในการลากเส้น Path ซึ่งสามารถดัดโค้งตามรูปภาพได้
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Custom Shape Tool
ใช้เลือกรูปภาพเลือกรูปภาพที่มีรูปร่างเฉพาะจาก Custom Shape List
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Animations Tool
ใช้เขียนโน๊ต หรือแนบเสียงไปกับรูปภาพได้
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Eyedropper Tool 
ใช้ในการดูดสีจากรูปภาพเพื่อใช้เป็นต้นแบบของสีกับงานชิ้นอื่นๆ
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Measure Tool
ใช้วัดระยะห่าง, ตำแหน่งและมุมองศาระหว่างภาพ
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Hand Tool 

ใช้เลื่อนภาพที่อยู่ในหน้าต่างเดียวกัน
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Zoom Tool 

ใช้ในการขายและย่อส่วนการแสดงภาพบนหน้าจอ

	
	
	
	


การใช้งาน Palettes


Palettes คือ Dialog ที่ใช้ตรวจสอบและกำหนดคุณสมบัติต่าง ๆ ของรูปภาพ เช่น Palette ของ Navigator และ Info, Palette ของ Color, Swatches เป็นต้น 
Palette ต่าง ๆ จะถูกจัดเป็นกลุ่ม ๆ สำหรับการซ่อนหรือแสดง Palettes นั้นให้คลิกที่เมนูคำสั่ง Window จากนั้นเลือก Palette ที่ต้องการซ่อนหรือแสดง Palette ใดถูกเปิดใช้งานอยู่จะมีเครื่องหมายถูก
หน้า Palette 
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Navigator Palette
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Navigator Palette เป็น Palette ที่ใช้สำหรับเปลี่ยนขนาดมุมมอง ที่จอภาพตามความเหมาะสม ประกอบด้วยส่วนต่าง ๆ ดังนี้
1. Proxy Preview Area คือส่วนที่แสดงถึงขนาดของภาพในชิ้นงาน กรอบสีหมายถึงขนาดของชิ้นงาน หากกรอบของ Proxy Preview อยู่ริมสุดของภาพแสดงว่าภาพนั้นมีขนาดพอดีกับชิ้นงาน
2. ตัวเลขเปอร์เซ็นต์ของภาพ คือส่วนที่ใช้กำหนดขนาดมุมมองของภาพ ซึ่งอยู่ในรูปแบบของเปอร์เซ็นต์ โดยค่าของขนาดภาพจริงจะเท่ากับ 100 เปอร์เซ็นต์
3. Zoom Out & Zoom In คือส่วนที่ใช้กำหนดขนาดมุมมองของภาพ ประกอบด้วยส่วนที่ใช้กำหนด 3 ส่วน คือ
3.1 Zoom Out คือส่วนที่อยู่ด้านซ้ายสุด ใช้สำหรับย่อขนาดมุมมองของภาพให้เล็กลง
3.2 Zoom In คือส่วนที่อยู่ด้านซ้ายสุด ใช้สำหรับขยายขนาดมุมมองของภาพให้ใหญ่ขึ้น
3.3 Zoom Slider คือส่วนที่เป็นแถบเลื่อน หากเลื่อนทางด้านซ้ายจะย่อขนาดมุมมองของภาพให้เล็กลง แต่หากเลื่อนมาทางขวาจะขยายขนาดมุมมองของภาพให้ใหญ่ขึ้น
Color Palette


Color Palette คือ Palette ที่ทำหน้าที่เป็นจานสี ซึ่ง Mode สีที่ปรากฏในภาพจะเป็นลักษณะการผสมใน Mode RGB มีส่วนประกอบต่าง ๆ ดังนี้
1. Set foreground color คือส่วนแสดงสีของ foreground

2. Set background color คือส่วนแสดงสีของ background

3. RGB slider คือส่วนที่ใช้กำหนดค่าของการผสมสีใน Mode RGB ซึ่งสามารถเลื่อนเพื่อปรับค่าสีได้จากแถบ slide หรือระบุเป็นตัวเลข (0-255)

4. [image: image97.jpg]8) | Tolrance: [F2 7 Antiatased 7 Contguous T~ Use Al Layers




Sample color คือส่วนสำหรับกำหนดค่าสีในลักษณะจุ่มเลือกสี
Swatches Palette


Swatches Palette คือ Palette ที่ทำหน้าที่สำหรับเก็บสีหลักๆ ที่นิยมใช้ สามารถเลือกนำมาใช้ได้ทันทีและถ้าหากว่าคุณมีสีที่ต้องการใช้เป็นประจำ สามารถบันทึกสีนั้นไว้ใน Palette นี้ได้ 
การบันทึกสีที่ต้องการไว้ที่ Swatches Palette สามารถทำได้โดยเลือกสีที่ต้องการ จากนั้นคลิกเมาส์ที่ปุ่มบันทึกสีใหม่ที่ Swatches Palette จะสามารถบันทึกสีที่ต้องการได้

[image: image39]
Styles Palette



Styles Palette คือ Palette ที่มีไว้สำหรับเก็บลวดลายอย่างลวดเร็ว สามารถเลือกลวดลายจาก Palette นี้ไปใช้ในภาพ จะทำให้ภาพที่คุณวาดไว้เปลี่ยนไปตามลวดลายที่เลือกไว้ทันที และยังสามารถสร้างลวดลายให้ขึ้นมาเองได้ด้วย
การใช้งานนั้นสามารถทำได้โดยเลือกที่ Layer ที่ต้องการจะทำ Style แล้วคลิกเลือกที่ Style บน Styles Palette จากนั้น Layer จะเปลี่ยนตาม Style นั้นๆ
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History Palette



History Palette เป็น Palette ที่แสดงขั้นตอนวิธีการต่าง ๆ ที่ใช้ทำงานกับไฟล์ภาพตามลำดับโดยสามารถย้อนกลับไปยังการทำงานต่าง ๆ ในลำดับชั้นและยกเลิกได้ ประกอบด้วยส่วนต่าง ๆ ดังนี้

1. ส่วนที่ใช้กำหนดข้อมูลของการใช้ History Brush Tool


2. เป็นภาพที่แสดงรายละเอียดของงานที่ทำตามลำดับ

3. History State เป็นลำดับขั้นตอนวิธีการต่าง ๆ ที่ได้กระทำลงไป

4. History State Slider คือส่วนชี้ว่าขณะนี้อยู่ที่ลำดับใด

5. New Document คือส่วนที่ใช้สร้างกระดาษทำการใหม่ โดยคัดลอกภาพจากลำดับที่ชี้อยู่

6. New Snapshot คือส่วนที่ใช้สร้าง Snapshot ใหม่

7. Trash Button คือส่วนที่ใช้ลบขั้นตอนการทำงานกับไฟล์ภาพในลำดับที่เลือกอยู่ออก
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Layer Palette


Layer Palette เป็น Palette ที่เก็บชิ้นงานหรือภาพทั้งหมด เรียกว่า Layer ซึ่งจะเรียงลำดับก่อนหลัง ทำให้เกิดความสะดวกในการจัดการแก้ไขโดยไม่เกิดผลกระทบกับชิ้นงานหรือภาพอื่น ๆ โดยจะแก้ไขเฉพาะชิ้นงานหรือภาพใน Layer ที่เลือกเท่านั้น ส่วนประกอบของ Layer Palette มีดังนี้
1. Indicates Layer Visibility  คือส่วนที่กำหนดการแสดงผลของ Layer หากมีสัญลักษณ์รูปตาแสดงว่าภาพที่อยู่ใน Layer ดังกล่าวถูกแสดงบน Work Area หากไม่มีแสดงว่า Layer นั้นถูกซ่อนหรือไม่แสดงผล
2. Indicates if Layer is Linked คือส่วนที่แสดงว่า Layer ใดกำลังถูกทำงาน Layer นั้น จะมีสัญลักษณ์รูปพู่กัน นอกจากนี้ยังสามารถกำหนดให้ Layer อื่นเลื่อนตำแหน่งตาม Layer ที่กำลังทำงานอยู่ได้โดยการคลิกให้ Layer อื่นเปลี่ยนเป็นสัญลักษณ์รูปโซ่
3. Add a Layer Style คือส่วนที่ใช้ใส่ Effect เช่น แสง เงา ต่าง ๆ ให้กับภาพใน Layer

4. Add a mask คือส่วนที่ใช้เพิ่ม Mask หรือเพิ่ม 1 Layer ซ้อนทับ Layer ที่กำลังทำงานอยู่ โดยทั้ง 2 จะถือเป็น Layer เดียวกัน
5. Create a new set คือส่วนที่ใช้สร้าง Folder สำหรับเก็บ Layer ต่าง ๆ เข้าด้วยกัน
6. Create new fill or adjustment layer คือส่วนที่ใช้ปรับค่าสี ความคมชัด แสงและความสว่างในแบบต่าง ๆ ของภาพใน Layer

7. Create a new layer คือส่วนที่ใช้สร้าง Layer ใหม่
8. Delete layer คือส่วนที่ใช้ลบ Layer

9. Layer Thumbnail คือส่วนที่แสดงว่า Layer นั้นมีภาพใดอยู่
10. Lock คือส่วนที่ใช้ Lock ในรูปแบบต่างๆ
11. Opacity คือส่วนที่ใช้ทำให้ Layer นั้นโปร่งใส
12. Fill คือส่วนที่ใช้ทำให้ Fill ใน Layer นั้นโปร่งใส
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หมายเหตุ:
 แถบสีน้ำเงินแสดงว่ากำลังทำงานกับ Layer 2 
การจัดลำดับ Layer สามารถทำได้โดยนำเมาส์คลิกค้างไว้ที่ Layer แล้วลากไปยังตำแหน่งที่ต้องการ หรือใช้เมนูคำสั่ง Layer -> Arrange
· Bring to Front คือ ส่ง Layer ไปยังตำแหน่งบนสุดของทุก Layer
· Bring Forward คือ ส่ง Layer ขึ้นไปตำแหน่งบน 1 ขั้น
· Send Backward คือ ส่ง Layer ลงไปตำแหน่งล่าง 1 ขั้น
· Send to Back คือ ส่ง Layer ลงไปตำแหน่งล่างสุดของทุก Layer แต่ยกเว้น Background Layer
 การเปิดไฟล์ภาพ (Open)
1. คลิกที่เมนูคำสั่ง File ที่แถบ Menu bar จากนั้นเลือกคำสั่ง Open

[image: image40.jpg]|Fle Edt Image Layer Select Fiter View Window Help
New, Crisn

e =] | Toleranc
Browse, ghm(tmo
| Openas. A0

Open Recent »




2. จะปรากฏ Dialog แสดงรายชื่อไฟล์ต่าง ๆ ดังภาพ เพื่อเลือกไฟล์ที่ต้องการเปิดมาใช้งาน
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3. คลิกเลือกไฟล์ที่ต้องการเปิดใช้งาน จากนั้นคลิกปุ่ม Open

การสร้างไฟล์ใหม่ (New)
1. คลิกที่เมนูคำสั่ง File ที่แถบ Menu bar จากนั้นเลือกคำสั่ง New
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2. จะปรากฏ Dialog สำหรับกำหนดคุณสมบัติต่าง ๆ ของไฟล์ภาพดังนี้
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· Name คือ ชื่อของชิ้นงาน
· Image Size คือ ขนาดภาพดังรูป ระบุไว้ 2.25M และใส่ตัวเลขขนาดความกว้างและความยาว สามารถเลือกเปลี่ยนหน่วยได้ เช่น เปลี่ยนจากหน่วยของ cm เป็น pixels เป็นต้น และยังสามารถเลือกขนาดจาก Preset Size ที่เตรียมไว้ให้แล้วได้ เช่นถ้าต้องการขนาด 640 x 480 pixel เป็นต้น
· Resolution คือ ความละเอียดของภาพ โดยใส่ตัวเลขค่าความละเอียดของภาพ เช่น งานเว็บหรือรูปที่แสดงบนคอมพิวเตอร์เท่ากับ 72 pixels/inch งานสิ่งพิมพ์เท่ากับ 150-200 pixels/inch
· Mode คือ โหมดสีของภาพ ซึ่งประกอบไปด้วย โหมดสี Bitmap, Grayscale, 

RGB Color, CMYK Color, Lab Color 

· Contents คือ สีพื้นหลังของภาพ มีดังนี้
· White กำหนดให้สีพื้นหลังเป็นสีขาว
· Background กำหนดให้สีพื้นหลังเป็นสีเดียวกับ Background

· Transparent ไม่มีพื้นหลัง
3. หลังจากกำหนดคุณสมบัติต่าง ๆ ให้คลิกปุ่ม OK เพื่อสร้างไฟล์
การบันทึกข้อมูลลงบนไฟล์ (Save)

หลังจากตกแต่งไฟล์ภาพเรียบร้อย จะต้องเก็บบันทึกข้อมูลลงบนไฟล์ (Save) สำหรับการเรียกใช้งานในครั้งต่อไป โปรแกรมมีการบันทึกข้อมูลลงบนไฟล์ (Save) อยู่ 3 ลักษณะ คือ 
· Save บันทึกไฟล์ในรูปแบบ (Format) ปกติ ซึ่งจะอยู่ในรูปแบบ (Format) ของ PSD

· Save As บันทึกไฟล์ในรูปแบบ (Format) อื่น ๆ ได้ เช่น JPEG, BMP, GIF เป็นต้น
· Save for Web บันทึกไฟล์ในรูปแบบ (Format) สำหรับการใช้งานบนเว็บ เช่น ไฟล์ Html และไฟล์รูปภาพ JPEG, GIF, PGN เป็นต้น
ในที่นี่เป็นแสดงการใช้งานของ Save และ Save As

1. คลิกที่เมนูคำสั่ง File ที่แถบ Menu bar จากนั้นเลือกคำสั่ง Save หรือ Save As
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2. จะปรากฏ Dialog สำหรับกำหนดคุณสมบัติต่าง ๆ ของไฟล์ภาพดังนี้
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· ชื่อไฟล์ (File Name)

· รูปแบบของไฟล์ (Format)

· กำหนดคุณสมบัติของการบันทึกไฟล์ (Save Options)

· As a Copy บันทึกไฟล์เป็นชื่ออื่น รูปแบบ (Format) อื่น ขณะที่ไฟล์เดิมกำลังเปิดใช้งาน
· Layers จะเก็บคุณสมบัติของ Layer ต่าง ๆ 
· Use Proof setup เก็บค่าโหมดสีที่จะใช้แสดงสีของภาพก่อนจะพิมพ์
· Thumbnail กำหนดให้ไฟล์ที่บันทึก (Save) สามารถแสดงภาพตัวอย่างใน Dialog ของการเปิดไฟล์
· Use Lower Case Extension กำหนดให้นามสกุลไฟล์เป็นอักษรตัวเล็ก
3. หลังจากกำหนดคุณสมบัติต่าง ๆ ให้คลิกปุ่ม Save เพื่อบันทึกข้อมูลลงบนไฟล์
การกำหนดพื้นที่ เพื่อแก้ไขและตกแต่งภาพ (Selection)

Marquee Tool เป็นเครื่องมือสำหรับการกำหนด Selection โดยคลิกเลือก Marquee Tool จาก Tool box จะมีให้เลือกใช้งาน 4 รูปแบบตามความเหมาะสม
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Rectangular Marquee Tool 

สำหรับการสร้าง Selectionเป็นสี่เหลี่ยมผืนผ้า และ
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สี่เหลี่ยมจัตุรัส
Elliptical Marquee Tool  
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สำหรับการสร้าง Selection เป็นวงกลมและวงรี
Single Marquee Tool 
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สำหรับการสร้าง Selection เป็นพื้นที่รูปเส้นตรงในแนวนอน ความกว้าง 1 pixel

Single Column Marquee Tool 

สำหรับการสร้าง Selection เป็นพื้นที่รูปเส้นตรงในแนวตั้ง ความกว้าง 1 pixel 
วิธีการใช้งาน Marquee Tool

1. ให้คลิกที่ Marquee Tool บน Tool Box หรือหากต้องการเลือกรูปแบบอื่นของ Marquee Tool ให้คลิกเมาส์ค้างไว้ แล้วคลิกเลือกรูปแบบที่ต้องการสร้าง Selection

2. [image: image107.jpg]


วางตำแหน่งของ Cursor  รูป เพื่อกำหนดจุดเริ่มสำหรับการสร้าง Selection

3. ให้คลิกเมาส์ค้างไว้และลากเพื่อกำหนดขนาดของพื้นที่ที่ต้องการ แล้วปล่อยเมาส์ จะปรากฏเส้นประของ Selection ดังภาพ
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Marquee options
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เมื่อคลิกเลือกใช้งาน Marquee Tool ที่ Tool options bar เราจะสามารถกำหนดคุณสมบัติต่าง ๆ ของ Marquee tool ได้ดังนี้
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1. การแก้ไข Selection จะมีให้เลือก 4 รูปแบบคือการกำหนดเลือก Selection ใหม่ การเพิ่ม ตัดและลด Selection และการสร้าง Selection ด้วยวิธี Intersect การดังนี้

เมื่อคลิกเมาส์จะเป็นการสร้าง Selection ขึ้นใหม่
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สร้าง Selection เพิ่มขึ้น โดยพื้นที่ Selection ก่อนหน้าจะไม่หายไป แต่จะถูกรวมเข้าด้วยกัน
ลบพื้นที่ของ Selection ออกจาก Selection ก่อนหน้า
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เป็นการสร้าง Selection ใหม่ในพื้นที่ Selection เดิม ด้วยวิธี Intersect จากพื้นที่ Selection ที่กำหนดใหม่และ Selection ก่อนหน้า ที่มีพื้นที่เดียวกัน

2. Feather กำหนดความฟุ้งเบลอของขอบ Selection ภาพ มีค่าตั้งแต่ 1 – 250 หากกำหนดค่ามากความฟุ้งเบลอจะมากตาม
3. Style ของ Marquee Options มี 3 รูปแบบคือ

· Normal เลือกขนาดอิสระ ขนาดของ Selection จะเปลี่ยนไปตามการเคลื่อนตำแหน่งเมาส์
· Constrained Aspect Ratio  กำหนดขนาดของ Selection โดยยืดหยุ่นตามอัตราส่วนของความกว้าง (Width) และความสูง (Height)
· Fixed Size กำหนดขนาดของ Selection ตามอัตราส่วนของความกว้าง (Width) และความสูง (Height) ที่แน่นอน
4. Width การกำหนดความกว้างของ Selection

5. Height การกำหนดความสูงของ Selection

Lasso Tool
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เป็นเครื่องมือที่สามารถสร้าง Selection ได้อย่างอิสระ มีความยืดหยุ่นสูง เมื่อคลิก Lasso Tool ที่ Tool bar จะมีให้เลือกทั้งหมด 3 รูปแบบดังนี้

1. Lasso Tool


 เป็นการสร้าง Selection อย่างอิสระ วิธีการใช้งานเมื่อคลิกเมาส์ค้างแล้วลากไปตามขอบของพื้นที่ Selection ที่ต้องการ จนมาบรรจบที่จุดเริ่มต้นแล้วจึงปล่อยเมาส์จะปรากฏเส้นประของ Selection สามารถกำหนดคุณสมบัติของ Lasso Tool ต่าง ๆ ได้ดังนี้
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· Feather กำหนดความฟุ้งเบลอของขอบพื้นที่ Selection
· Anti-aliased กำหนดให้ขอบของพื้นที่ที่เลือกมีความเรียบยิ่งขึ้น ไม่ขรุขระ
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2. Polygonal Lasso Tool

เป็นการสร้างพื้นที่ของ Selection ในลักษณะของรูปหลายเหลี่ยม คลิกเมาส์บนภาพเพื่อกำหนดจุดเริ่มต้นในครั้งแรกแล้ว ลากเมาส์จะปรากฏเส้นต่อจากจุดเริ่มต้นกับปลายเมาส์ วิธีการใช้งานเมื่อคลิกเมาส์จะเกิดเส้นขอบของพื้นที่ Selection ที่เป็นเส้นตรงเชื่อมจากจุดต้นมายังจุดปลายเมาส์ที่คลิก ให้ทำแบบนี้เรื่อย ๆ เพื่อสร้างเส้นขอบของ Selection จนสุดท้ายให้คลิกเมาส์บรรจบที่จุดเริ่มต้นครั้งแรก จะเกิด Selection ขึ้น สำหรับการกำหนดคุณสมบัติจะเหมือนกับ Lasso Tool
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3. Magnetic Lasso Tool

เป็นการสร้างพื้นที่ของ Selection อย่างอิสระและรวดเร็วในลักษณะของแม่เหล็กที่ดูดเข้าหาสี โดย Magnetic Lasso Tool จะใช้ความแตกต่างระหว่างสีที่เลือกกับสีของ Background เป็นตัวกำหนดขอบเขตพื้นที่ Selection วิธีการใช้งานเมื่อคลิกเมาส์เพื่อกำหนดจุดเริ่มต้นแล้ว ให้ปล่อยเมาส์แล้วลากเมาส์ตามขอบเขตพื้นที่ที่ต้องการเลือก Magnetic Lasso Tool จะเลือกขอบเขตพื้นที่ Selection เองโดยอัตโนมัติ จนสุดท้ายให้คลิกเมาส์บรรจบที่จุดเริ่มต้นครั้งแรก จะเกิด Selection ขึ้น คุณสมบัติของ Magnetic Lasso Tool มีเพิ่มจาก Lasso Tool ได้ดังนี้
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1. Width มีค่าตั้งแต่ 1-40 pixels เป็นการกำหนดให้โปรแกรมทำการตรวจสอบหาขอบเขตของพื้นที่ที่เลือก นับตั้งแต่จุดที่เมาส์ชี้อยู่ไป X pixels เพื่อกำหนดขอบเขต
2. Edge Contrast มีค่าตั้งแต่ 0-100% หากมีค่ามากจะทำให้เส้นขอบของพื้นที่ที่เลือกอยู่ระหว่างสีที่Contrast กันมาก
3. Frequency มีค่าตั้งแต่ 0-100 pixels หากค่าความถี่มากจะทำให้มีการกำหนดจุดในแต่ละช่วงของการเลือกมาก ทำให้โปรแกรมสามารถเลือกพื้นที่อย่างมีความถูกต้องมากขึ้น
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Magic Wand Tool


กำหนดพื้นที่ของ Selection โดยเลือกบริเวณที่มีค่าสีใกล้เคียงกัน วิธีการใช้งานคือคลิกที่ปุ่ม บน Tool box แล้วคลิกเลือกพื้นที่ที่ต้องการสร้าง Selection นอกจากนี้แล้วยังสามารถกำหนดคุณสมบัติของ Magic Wand Tool ได้ดังนี้
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1. Tolerance มีค่าให้กำหนดตั้งแต่ 0 – 255 pixels เป็นค่าของจำนวนสีที่ใกล้เคียงกับสีที่ถูกเลือก
2. Anti-aliased กำหนดให้ขอบของพื้นที่ที่เลือกมีความเรียบยิ่งขึ้น ไม่ขรุขระ
3. Contiguous สามารถทำการเลือกบริเวณสีที่ใกล้เคียงกันได้เฉพาะในกลุ่ม pixels ที่ได้คลิกเลือกเท่านั้น ถ้าไม่ได้ Check ไว้จะเลือกบริเวณที่มีสีใกล้เคียงกันในภาพทั้งหมด
4. Use All Layers เลือกสีโดยมองทุก Layer เป็นเหมือน Layer เดียว หากไม่ถูก Check ไว้ หมายถึงใช้ Magic Wand Tool เฉพาะ Layer นั้นเท่านั้น
Crop Tool
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กำหนดพื้นที่ของ Selection โดยตัดส่วนที่เหลือที่ไม่ได้อยู่ในพื้นที่ของ Selection ในภาพทิ้งไป วิธีการใช้งานคือคลิกที่ปุ่ม           บน Tool box แล้วคลิกเมาส์ค้างไว้จากนั้นลากเมาส์เพื่อกำหนดพื้นที่ของ Selection แล้วจึงปล่อยเมาส์ เมื่อพร้อมที่จะตัดส่วนที่เหลือออก ให้คลิกปุ่ม           บน Tool options bar   หรือปุ่ม เพื่อยกเลิก นอกจากนี้เรายังสามารถกำหนดคุณสมบัติต่าง ๆ ของการตัดดังนี้
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1. Cropped Area เลือกผลลัพธ์ของภาพที่ตัด
· Delete ตัดภาพโดยลบส่วนที่เหลือออก
· Hide ตัดภาพ โดยซ่อนส่วนที่เหลือเอาไว้
2. Shield cropped area แสดงสีบนพื้นที่ส่วนที่เหลือที่จะถูกตัดออก

3. Color สีที่จะแสดงบนพื้นที่ส่วนที่เหลือ
4. Opacity ค่าความโปร่งแสงของสีบนพื้นที่ส่วนที่เหลือ
5. Perspective ปรับพื้นที่การตัดให้ได้ภาพที่มีมิติ
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คำสั่งพื้นฐานของ Selection
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· All กำหนดพื้นที่ Selection โดยใช้พื้นที่ของรูปภาพทั้งหมด

· Deselect ยกเลิกการกำหนดพื้นที่ Selection
· Reselect ย้อนกลับไปกำหนดพื้นที่ Selection หลังจากได้ยกเลิกไป

· Inverse เป็นการเปลี่ยนพื้นที่ของ Selection จากที่กำหนดไว้ให้เป็นพื้นที่ตรงข้าม
การใช้ Transform เพื่อปรับเปลี่ยนพื้นที่ Selection 
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คลิกที่เมนูคำสั่ง Edit ที่แถบ Menu bar จากนั้นเลือกคำสั่ง Transform

· Again กลับสู่รูปแบบเดิมก่อนหน้านี้ 1 ขั้น

· Scale ปรับเปลี่ยนแบบ Scale ตามแนวตั้ง แนวนอนและแนวทแยง

· Rotate หมุนพื้นที่ที่เลือก

· Skew ปิดเกลียวพื้นที่เลือก

· Distort การบิดเบือนพื้นที่เลือก
· Perspective ปรับขนาดของพื้นที่เลือกให้มีลักษณะการมองแบบ Perspective (แบบมีมิติ ความกว้าง ความยาว ความลึก)
· Rotate 180? CW หมุน 180 องศา
· Rotate 90? CW หมุน 90 องศาตามเข็มนาฬิกา
· Rotate 90? CCW หมุน 90 องศาทวนเข็มนาฬิกา
· Flip Horizontal กลับจากซ้ายเป็นขวา
· Flip Vertical กลับจากบนลงล่าง
การใช้งาน Foreground และ Background Color

การใช้งานในส่วนของ Foreground และ Background Color สามารถทำได้ที่ส่วนของ Toolbox ดังรูป
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สามารถเปลี่ยนสีได้โดยดับเบิ้ลคลิกที่ Foreground หรือ Background จะปรากฏ Color Picker ให้เปลี่ยนสี
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การใช้งาน Type Tool
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สามารถสร้างข้อความได้ทั้งในแนวนอนและแนวตั้ง           การสร้างข้อความแต่ละครั้งโปรแกรม Adobe Photoshop จะสร้าง Layer ใหม่อัตโนมัติ ลักษณะของข้อความจะมี 2 รูปแบบคือ

1. [image: image140.jpg]
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แบบ Point Type จะมีรูปแบบเป็นคำหรืออักษรสั้น ๆ 1 บรรทัด โดยกำหนดจุดเริ่มต้นของข้อความบนชิ้นงาน โปรแกรมจะสร้าง Type Layer ขึ้นมา และสามารถพิมพ์ข้อความลงไปได้  เมื่อพิมพ์ข้อความเรียบร้อย ให้คลิกที่ปุ่ม               เพื่อตกลง หรือคลิกปุ่ม  
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แบบ Paragraph Type จะมีรูปแบบเป็นข้อความที่มีหลายบรรทัด โดยจะอยู่ภายในขอบเขตที่กำหนดเดียวกัน (Bounding box) โดยกำหนดจุดขอบเขตของข้อความที่ใส่ โปรแกรมจะสร้าง Type Layer ขึ้นมา และสามารถพิมพ์ข้อความและจัดเป็น Paragraph ได้จาก Paragraph Palette เมื่อพิมพ์ข้อความเรียบร้อย ให้คลิกที่ปุ่ม               เพื่อตกลง หรือคลิกปุ่ม 
[image: image144.jpg][Normal <] Opacity:
Lo e
&7 T
®|@ icturs
-

Suctyround. a






[image: image145.jpg]tock O 7 @




หากต้องการแก้ไขข้อความที่พิมพ์ให้คลิกที่ปุ่ม          แล้วลากเมาส์บนข้อความที่ต้องการแก้ไขให้เกิดแถบสี แล้วจึงปรับแก้ไขข้อความ หรือเปลี่ยนแปลงคุณสมบัติต่าง ๆ ของข้อความบน Tool options bar เมื่อแก้ไขเรียบร้อยแล้วจึงคลิกปุ่ม 
หากต้องการตัวอักษรที่มีลวดลายของภาพ Background เช่น                                                   สามารถทำได้โดยใช้สร้าง Selection ของตัวอักษร ซึ่งมีวิธีให้คลิกที่ปุ่ม          เพื่อเลือก Horizontal Type Mask Tool หรือ Vertical Type Mask Tool แล้วพิมพ์ข้อความที่ชิ้นงาน เมื่อพิมพ์เสร็จ จะเกิด Selection ที่เป็นตัวอักษร จากนั้นสามารถที่จะคัดลอกลวดลายภาพที่ต้องการตาม Selection ของข้อความนั้นได้

คุณสมบัติต่าง ๆ ของ Type Tool

Warp Text เมื่อคลิกปุ่ม          จะปรากฏ Dialog สำหรับกำหนดค่าเพื่อปรับแต่งรูปทรงของข้อความ
ตัวอย่าง Warp Text
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การใช้งาน Layer

ลักษณะการทำงานของ Layer เป็นเหมือนแผ่นใสวางซ้อนกันเป็นลำดับของรูปภาพ ช่วยแยกการทำงานให้ชัดเจน โดยการทำงานแต่ละครั้งจะมีผลกับ Layer ที่เลือกอยู่เท่านั้น การมองจะอยู่ในลักษณะมองจากด้านบนลงมาด้านล่าง วิธีการเรียกใช้งาน Layer คลิกที่เมนูคำสั่ง Window ที่แถบ Menu bar เลือกคำสั่ง Show Layer ถ้าหากพบว่า Hide Layers แสดงว่า Palette Layer ถูกแสดงแล้ว

Active Layer คือ Layer ที่กำลังถูกทำงานอยู่ สามารถเลือก Layer ได้จากการคลิกที่แถบ Layer จากนั้นช่อง Indicates if Layer is จะมีสัญลักษณ์รูปพู่กันปรากฏ หากต้องการเคลื่อนย้าย Layer โดยให้ Layer อื่นเคลื่อนย้ายตามให้คลิกที่ช่อง Indicates if Layer is ให้เป็นรูปโซ่เพื่อเชื่อม Layer เข้าด้วยกัน 

การเปลี่ยนลำดับของ Layer สามารถทำได้โดยคลิกเมาส์ที่ Layer ค้างไว้แล้วลากไปยังลำดับของ Layer ที่ต้องการแล้วปล่อยเมาส์

ที่ช่อง Indicates Layer Visibility หากปรากฏสัญลักษณ์รูปตาหมายความว่า Layer นั้นถูกแสดงอยู่ หากต้องการซ่อน Layer ไม่ให้แสดงผล ให้คลิกที่ช่อง Indicates Layer Visibility สัญลักษณ์รูปตาจะหายไป


การสร้าง Layer ขึ้นใหม่ ให้คลิกที่ปุ่ม            หากต้องการคัดลอก Layer ให้คลิก Layer ที่ต้องการแล้วปล่อยลงที่ปุ่มนี้เช่นเดียวกัน แต่ถ้าต้องการลบ Layer หลังจากคลิกเลือก Layer ที่ต้องการแล้วให้คลิกที่ปุ่ม 

การ Lock Layer 
เป็นการกำหนดคุณสมบัติต่าง ๆ เพื่อบังคับไม่ให้ Layer ถูกเปลี่ยนแปลงหรือได้รับผลกระทบใด ๆ มีทั้งหมด 4 รูปแบบดังนี้

1. Lock transparent pixels ห้ามไม่ให้เติมสีหรือปรับแก้สีลงไปใน pixels ที่โปร่งแสงบน Layer ได้
2. Lock image pixels ห้ามไม่ให้มีการแก้ไขหรือตกแต่งภาพบน Layer

3. Lock position ห้ามไม่ให้มีการเคลื่อนย้ายตำแหน่งของ Layer 

4. Lock all ห้ามโดยใช้การกำหนดคุณสมบัติของทั้ง 3 ข้อที่กล่าวมา


การ Merge Layer 
เป็นการรวมชั้นของ Layer ตั้งแต่ 2 ชั้นขึ้นไปมาไว้รวมกัน โดยคลิกที่ปุ่ม       แล้วจะปรากฏ Dialog สำหรับเลือกแบบต่าง ๆ ของการ Merge Layer ดังนี้


· Merge Down หรือ Merge Linked เป็นการรวม Layer ที่ใช้งานอยู่กับ Layer ที่อยู่ลำดับถัดลง โดยถ้า Layer ที่อยู่ลำดับถัดไปมีสัญลักษณ์รูปโซ่ จะมีข้อความว่า Merge Linked แต่หากไม่มีรูปโซ่จะมีข้อความว่า Merge Down

· Merge Visible เป็นการรวม Layer ที่ถูกแสดงหรือมองเห็นได้ทั้งหมด
· Flatten Image เป็นการรวม Layer ทุกลำดับชั้นเป็น Layer เดียว โดยมีชื่อว่า Background และจะลบ Layer ที่ถูกซ่อนทิ้งไป
หากต้องการเปลี่ยนชื่อของ Layer ให้คลิกเลือก Layer Properties จะปรากฏ Dialog ของ Layer ซึ่งสามารถเปลี่ยนชื่อของ Layer ได้ และแถบสีได้
การจัด Set ของ Layer

เป็นการรวบรวม Layer ต่าง ๆ มาไว้เป็นกลุ่ม Layer Set สามารถใช้คำสั่งต่าง ๆ เหมือน Layer ทั่ว ๆ ไป เช่น การดู คัดลอก เคลื่อนย้าย และการเปลี่ยนลำดับ ยกเว้นคำสั่งบางคำสั่ง เช่น Layer Effect ดังนั้นใช้งานคำสั่งใด ๆ ของ Layer Set จะเกิดขึ้นกับ Layer ภายในทุก Layer

การสร้าง Layer Set คลิกที่ปุ่ม          เพื่อสร้าง Set หลังจากนั้นให้คลิกเลือก Layer ที่ต้องการจัดเก็บค้างไว้ แล้วลากที่ Layer Set จากนั้นให้ปล่อยเมาส์


หากดับเบิ้ลคลิกที่ Layer Set จะปรากฏ Dialog ของ Layer Set Properties ซึ่งสามารถเปลี่ยนชื่อของ Layer Set ได้ และแถบสีได้
การทำภาพโดยใช้ Filter


ฟิลเตอร์ (Filter) คือการตกแต่งภาพด้วยเทคนิคพิเศษ ที่สามารถปรับเปลี่ยนรูปแบบของภาพตามความต้องการของงาน เราสามารถใช้งาน Filter ได้โดยเลือก Menu > Filter > เลือกใช้ Filter ที่ต้องการ
ตัวอย่างการใช้ Filter

ที่ Menu Bar จะมีปุ่ม Filter(1) อยู่ เมื่อกดแล้วจะมี Filter Menu ปรากฏขึ้นเลื่อนเมาส์ไปยัง Filter “Blur”(2) จะมีเมนูย่อยเพิ่มขึ้นมา ให้กดเลือกที่ “Redial Blur”(3)
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เมื่อเลือกเสร็จแล้วจะปรากฏหน้าจอการปรับเปลี่ยนลักษณะของ Filter สามารถที่จะกำหนดได้ตามต้องการ (ใน Filter แต่ละตัวนั้น หน้าจอการปรับเปลี่ยนลักษณะของ Filter จะไม่เหมือนกัน) เสร็จแล้วกดปุ่ม OK เพื่อจบขั้นตอนการทำงานของ Filter

[image: image50.jpg]Edt Ivage Layer Select Fiter View Window Help

Mjr_‘u? 8 | Fastar: B I ntsises | sty forma

2000 Aston Martin Vanquish

Amount

|

=t Caedl

Blur Center

S,

[~ Blur Methad:
© Spin
& Zoom

[ Quaiiy:
© Datt
& Good

© Best





จะได้ภาพที่มีการตกแต่งด้วย Filter ออกมา
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ตัวอย่าง Filter ที่น่าสนใจ 
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ภาพต้นแบบ
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Smudge Stick
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Gaussian Blur
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Radial Blur
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Angled Strokes
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Mosaic
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Facet
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Fragment
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Lens Flare
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Lighting Effects
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Sharpen
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Graphic Pen
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Halftone Pattern
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Stamp
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Water Paper
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Wind


การใช้งาน Layer Style
คลิกที่เมนู Layer > Layer Style > Blending Options จะปรากฏหน้าต่างดังภาพข้างล่าง
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(1) คือ Style ที่ต้องการใช้กับ Layer ที่เราเลือกไว้ จะมีให้เลือก 10 แบบจากบนลงล่าง
(2) คือ การกำหนดค่าต่างๆ ของแต่ละ Style ซึ่งจะแตกต่างกันไปในแต่ละ Style
ตัวอย่างการใช้ Layer Style
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Drop Shadow
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Inner Shadow
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Outer Glow
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Inner Glow
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Bevel and Emboss
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Satin
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Gradient Overlay
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Pattern Overlay
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Stroke


การเปลี่ยนรูปร่างของรูป (Transform)
เราสามารถเปลี่ยนแปลง Layer ในรูปแบบต่างๆได้เช่น การย่อ/ขยาย การหมุนภาพ การบิดภาพ ด้วยคำสั่ง Transform โดยคลิกเลือก Edit > Transform > (เลือก Transform Function ที่ต้องการ)

ลักษณะของ Transform
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ภาพต้นแบบ
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Scale
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Rotate
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Skew
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Distort
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Perspective


การปรับค่าความสว่าง/ความคมชัด (Brightness/Contrast)
การปรับความสว่าง-ความมืดของภาพ และการตัดกันของสีที่ชัดเจนขึ้นนั้น สามารถทำได้โดยใช้คำสั่ง Brightness/Contrast โดยเลือกคลิกที่ Image > Adjust > Brightness/Contrast
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            ภาพต้นแบบ


Brightness


Contrast

การปรับขนาดของชิ้นงาน 
Image Size

Image Size คือการ ลด/ ขยายรูปภาพโดยสามารถใช้คำสั่งนี้ได้จากเมนู Image > Image Size… จะปรากฏหน้าต่างที่ให้เรากำหนดขนาดของภาพขึ้นมาดังรูป
[image: image87.jpg]Pixel Dimensions: 364K [

width: [355 pirels

(Do pr—— [ooee

Document Size:

Cancel

widh:  [1408 o < :l

Height: 1058 o <

BESD@
»

¥ Constrain Proportions

¥ Resample Image: [ Bicubic =

155 pivels/inch





(1) Width(กว้าง) และ Height(สูง) ของรูปภาพ สามารถกำหนดได้ตามต้องการ โดยมีหน่วยให้เลือกสองแบบคือ Pixel และ %

(2) Constrain Proportions Sign เมื่อสัญลักษณ์นี้ปรากฏดังรูป แสดงว่าเมื่อเราได้กำหนดขนาดภาพไว้ด้านใดด้านหนึ่งแล้ว โปรแกรมจะกำหนดสัดส่วนของด้านที่เหลือให้เอง(อัตราส่วนที่เท่ากัน) ผลที่ได้ก็คือ ไม่ว่าจะย่อหรือขยาย รูปภาพที่ออกมาก็จะมีอัตราส่วนของ กว้าง x สูงเท่าเดิม
(3) Constrain Proportions Check Box จาก (2) เมื่อเราไม่ต้องการ ย่อ/ขยาย รูปภาพให้เหมือนอัตราส่วนเดิมให้คลิกที่ Check Box ออก เครื่องหมาย ( จะหายไปหลังจากนั้นการกำหนดขนาด กว้างและสูงสามารถกำหนดได้ตามต้องการ
Canvas Size

การ Canvas Size คือการลด/ ขยายพื้นที่รูป โดยเพิ่มพื้น Background และสามารถขยายรูปโดยกำหนดทิศทางได้ ดังรูป


ตัวอย่างการ Canvas Size

[image: image88]
การตัดกรอบของรูป (Crop)

การ Crop คือ การตัดกรอบภาพเอาเฉพาะที่ต้องการ นอกจากรูปภาพจะมีขนาดเล็กเกินไปแล้ว บางครั้งรูปภาพก็มีขนาดใหญ่เกินไปได้เช่นกัน เราสามารถตัดกรอบภาพ (Cropping) ให้เหลือเฉพาะที่ต้องการได้โดยใช้เครื่องมือสองชนิดนี้ ดังนี้
วิธีที่1 การตัดกรอบภาพโดยเครื่องมือ Rectangular Marquee Tool
1. เลือกเครื่องมือ                  บนแถบเครื่องมือและกำหนด Feather ให้เท่ากับ 0 ก่อน
2. สร้าง Selection ที่ภาพในส่วนที่ต้องการตัดกรอบ 
3. เลือกเมนู Image -> Crop จะได้รูปจากการ Cropping 
วิธีที่ 2 การตัดกรอบภาพโดยเครื่องมือ Crop
1. เลือกเครื่องมือ                 บนแถบเครื่องมือ
2. สร้างพื้นที่ที่ต้องการตัดกรอบภาพ สังเกตว่าจะเกิดแถบสีเทาขึ้นบริเวณรอบนอกขอบกรอบที่สร้างขึ้นมา บริเวณสีเทาคือ บริเวณของรูปภาพที่ถูกตัดทิ้งนั่นเอง
3. ปรับแต่งพื้นที่ที่เลือก
4. คลิกปุ่ม            เพื่อยืนยันการตัดกรอบรูปตามต้องการ (กรณียกเลิกให้คลิกปุ่ม             แทน)
ตัวอย่างการ Cropping


Proxy Preview Area





ตัวเลขเปอร์เซ็นต์ของภาพ





Zoom Out 
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ลบสีที่มีอยู่





บันทึกสีใหม่





สีหลักๆ ที่ใช้เป็นประจำ





2





Menu bar





Tool options bar





Toolbox
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Status bar





Zoom In





Zoom Slider





การแก้ไข Selection





Feather





Style





Width





Height
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Indicates Layer Visibility





Active Layer
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ชนิดของตัวอักษร





ขนาดตัวอักษร





การวางตำแหน่งของข้อความ





รูปแบบตัวอักษร





ตกแต่งขอบตัวอักษร





สีตัวอักษร





Warp Text





การกำหนดรูป


แบบตัวอักษร
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Delete Style





New Style





Clear Style





ลวดลายต่างๆ





Set foreground color





Set background color





RGB slider





Sample color





3





4





Current Size ขนาดปัจจุบันของงาน


New Size ขนาดที่เพิ่มขึ้นจากขนาดของงาน


Relative เป็นคุณสมบัติบอกค่าขนาดของ New Size เครื่องหมาย ( ค่าในช่อง Width และ Height จะเป็น 0 สามารถเพิ่มพื้นที่งานโดยไม่ต้องรวมค่า Current Size 


Anchor ที่ทางที่ต้องการเพิ่มขนาดให้ไปในทิศทางที่ต้องการ








พื้นที่ที่เพิ่มจากการ Canvas





ภาพก่อนการ Cropping





ภาพหลังการ Cropping





Tool options bar





Toolbox





Status bar





Work area





Palettes
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ข้อความในแนวนอน








ข้อความในแนวตั้ง








ข้อความ Selection ในแนวนอน








ข้อความ Selection ในแนวตั้ง








Foreground Color





Background Color





Switch Color





Default Color








